Graduate Report Template

How to use it.
Focus for Graduate Report

- Summative demonstration of relevant learning
- Useful to support future endeavor
  - Performance – Detailed performance program note
  - Music Education – Teaching/Conducting score analysis and instructional plans
  - Composition – Music composed, performed, and supportive information
  - History – Research project
- Other – as developed by student and major professor
Find Templates

Graduate Report Documents

PERFORMANCE MASTER’S REPORT TEMPLATE (updated 2017)

- Sample History Report
- Sample Instrumental Performance Report
- Sample Vocal Performance Report
- Sample Piano Pedagogy Report
- Sample Piano Pedagogy Video Report

MUSIC EDUCATION CONDUCTING MASTER’S REPORT TEMPLATE (updated 2017)

- Sample Report
Formatting Your ETDR

Your ETDR must follow specific formatting guidelines. The ETDR Handbook outlines these requirements and demonstrates how to correctly format your ETDR to meet Graduate School requirements.

⚠️ Required Sections

ETDRs consist of required and optional sections. The ETDR templates contain a framework of all sections arranged in the required order.

🎓 Page Numbering

Page numbers must appear centered or right justified. Pages must be numbered according to the chart shown below.

💡 Format

You must use a consistent font and type size, have proper line spacing, margins, include a title page and footnotes/endnotes within your ETDR.

 maç Style

A thesis/dissertation/report should be written in a style appropriate to the academic discipline and should follow the formats cited in the ETDR Handbook.
Formatting Your ETDR

Your ETDR must follow specific formatting guidelines. The ETDR Handbook outlines these requirements and demonstrates how to correctly format your ETDR to meet Graduate School requirements.

_required sections_

ETDRs consist of required and optional sections. The ETDR templates contain a framework of all sections arranged in the required order.

Page Numbering

Page numbers must appear centered or right justified. Pages must be numbered according to the chart shown below.

<table>
<thead>
<tr>
<th>Table 1. ETDR page numbering requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ETDR Section</strong></td>
</tr>
<tr>
<td>Preliminary pages (all pages before the Table of Contents)</td>
</tr>
</tbody>
</table>
## Table 1. Basic Configuration for Word

<table>
<thead>
<tr>
<th>To make this setting</th>
<th>Follow this sequence of menus</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draft View</strong></td>
<td>View</td>
</tr>
<tr>
<td><strong>Style Area</strong></td>
<td>File</td>
</tr>
<tr>
<td><strong>Styles Pane</strong></td>
<td>Home</td>
</tr>
<tr>
<td><strong>Print Layout</strong></td>
<td>View</td>
</tr>
<tr>
<td><strong>Field Shading</strong></td>
<td>File</td>
</tr>
<tr>
<td><strong>Paste Options</strong></td>
<td>File</td>
</tr>
</tbody>
</table>

### Draft View
The Style Area is visible only in Draft View.

### Style Area
Displays at the left side of the screen and shows Styles applied to each portion of your document.

1. **Word** | Preferences | View
2. In the **Window** section, set **Style area width** to 1”.
3. Click **OK**.

### Styles Toolbox
Displays at right side of screen and shows a list of available Styles.

1. **View**
2. Under Toolbox, click **Styles**.

### Print Layout View
Displays page numbers (not visible in Normal view)

1. **View** | **Print Layout**

### Field Shading
Places a gray background in fields auto-generated by Word, including Table of Contents, List of Tables, etc.

1. **Word** | Preferences | View
2. In the **Show** section, set **Field shading** to **Always**.
3. Click **OK**.

### Paste Options
Displays the Paste Options menu after you paste a selection.

1. **Word** | Preferences | **Edit**
2. In the **Cut and paste options** section, checkmark **Show Paste Options** buttons.
3. Click **OK**.
Your title here in sentence case

by

Your Official Name (as KSIS record appears)

(previous degrees with punctuation, format, and date order, as shown in example below)
B.S., Kansas State University, 2010

A REPORT

submitted in partial fulfillment of the requirements for the degree

MASTER OF MUSIC
Click Navigation pane

Your title here in sentence case

by

Your Official Name (as KSIS record appears)

(previous degrees with punctuation, format, and date order, as shown in example below)
B.S., Kansas State University, 2010

A REPORT

submitted in partial fulfillment of the requirements for the degree

MASTER OF MUSIC

School of Music, Theatre, and Dance
College of Arts and Sciences

KANSAS STATE UNIVERSITY
Manhattan, Kansas
Your title here in sentence case

by

Your Official Name (as KIS record appears)

(comments, degree information, format, and date order, as shown in example below)

B.S., Kansas State University, 2010

A REPORT

Submitted in partial fulfillment of the requirements for the degree

MASTER OF MUSIC

School of Music, Theatre, and Dance
College of Arts and Sciences

KANSAS STATE UNIVERSITY
Manhattan, Kansas

Graduation Year

Approved by:
Major Professor
Name of your major professor
Chapter 1 - [Name of selection performed]

Biographical Information on the Composer

{Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below}

Table 1.1 List of compositions

<table>
<thead>
<tr>
<th>Name</th>
<th>Genre</th>
<th>Publisher</th>
<th>Difficulty</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>B1</td>
<td>C1</td>
<td>D1</td>
</tr>
<tr>
<td>2</td>
<td>A2</td>
<td>B2</td>
<td>C2</td>
<td>D2</td>
</tr>
<tr>
<td>3</td>
<td>A3</td>
<td>B3</td>
<td>C3</td>
<td>D3</td>
</tr>
</tbody>
</table>
Heading 2 is the primary heading in a chapter

Biographical Information on the Composer

{Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below}

Table 1.1 List of compositions

<table>
<thead>
<tr>
<th>Name</th>
<th>Genre</th>
<th>Publisher</th>
<th>Difficulty</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>B1</td>
<td>C1</td>
<td>D1</td>
</tr>
<tr>
<td>2</td>
<td>A2</td>
<td>B2</td>
<td>C2</td>
<td>D2</td>
</tr>
<tr>
<td>3</td>
<td>A3</td>
<td>B3</td>
<td>C3</td>
<td>D3</td>
</tr>
</tbody>
</table>

Table 1.2 Discography of Works

<table>
<thead>
<tr>
<th>Title</th>
<th>Recording Label</th>
<th>Numerical Code</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>B1</td>
<td>D1</td>
</tr>
</tbody>
</table>
YOU control the format of your content (Heading 2 example)

From Chapter 1 and on, you and your adviser decide how to format the content. The Graduate School wants consistency, so it will check your content for format issues such as:

- Blank pages
- Figures and tables outside the margins
- Inconsistent line spacing, margins, page numbering, etc.

Use headings and subheadings to organize content (Heading 3 example)

Headings 1-5 are for use in chapters (headings 6-9 are for appendices). Many students only use Headings 1, 2, and 3 in chapters. To organize a Heading 3 section, use Heading 4’s.

Heading 4 is special; it can also be put in a paragraph (Heading 4 example)

Notice that Heading 4 has a half-inch indent. This heading is designed to stand alone on
Suggestions

- Use the TEMPLATE to write your report
- Work in a single document file
- Use STYLES
- Use JPG or PNG for images (insert – don’t copy and paste)
- Resize images – no larger than 650 pixels in width
- Back-up regularly
Your title here in sentence case

by

Your Official Name (as KSIS record appears)

(previous degrees with punctuation, format, and date order, as shown in example below)
B.S., Kansas State University, 2010

A REPORT

submitted in partial fulfillment of the requirements for the degree

MASTER OF MUSIC

School of Music, Theatre, and Dance
College of Arts and Sciences

KANSAS STATE UNIVERSITY
Manhattan, Kansas

Graduation Year

Approved by:
Major Professor
Name of your major professor
Copyright and Abstract

Copyright

© Firstname Lastname YYYY.

Abstract

Type your content here, with no more than 500 words.

If you delete any lines on this page, retain the hidden Section Break below that provides proper page-number format. To see the Section Break, click the Home tab > Paragraph section > icon. On a Mac, the icon may be above the ribbon.
Do not type into Table of Contents and List of Figures and Table
Acknowledgements

The Acknowledgements page is optional. If you include it, retain the Acknowledgements heading and enter your text here.

Dedication

The Dedication page is optional. If you include it, retain the Dedication heading and enter your text here.

Preface

The Preface page is optional. If you include it, retain the Preface heading and enter your text here.

If you delete any lines on this page, retain the hidden Section Break below that provides proper page-number format. To see the Section Break, click the Home tab > Paragraph section > icon. On a Mac, the icon may be above the ribbon.
Chapter 1 - Introduction and Report Information

(Add content here. See Chapter 5 for details on using the ETDR template.)

Biographical Information on the Composer

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below.)

Table 3.2: List of compositions

<table>
<thead>
<tr>
<th>Name</th>
<th>Genre</th>
<th>Publisher</th>
<th>Difficulty</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>B1</td>
<td>C1</td>
<td>D1</td>
</tr>
<tr>
<td>2</td>
<td>A2</td>
<td>B2</td>
<td>C2</td>
<td>D2</td>
</tr>
<tr>
<td>3</td>
<td>A3</td>
<td>B3</td>
<td>C3</td>
<td>D3</td>
</tr>
</tbody>
</table>

Table 3.3: Discography of Works

<table>
<thead>
<tr>
<th>Title</th>
<th>Recording Label</th>
<th>Numerical Code</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>B1</td>
<td>D1</td>
</tr>
<tr>
<td>2</td>
<td>A2</td>
<td>B2</td>
<td>D2</td>
</tr>
<tr>
<td>3</td>
<td>A3</td>
<td>B3</td>
<td>D3</td>
</tr>
</tbody>
</table>

Theoretical Analysis

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below)

Stylistic and Technical Considerations

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below)

Introduction and Statement of Purpose

{write an introduction to your masters report describing the purpose of the project, what will be included in the report, what you learned through the process, and how you intend to use your learning in your future career}

Performance Information

{include the date, place, time, personnel, and any other pertinent information concerning the performance}

Music Examined

{introduce the musical selections, composers and educational reasoning for the selections}

Format of Analysis

{provide an overview of the format used in this paper for analysis of each piece}

Concert Program

{include the concert program}
Chapter 1 - [Name of selection performed]

(Add content here. See Chapter 5 for details on using the ETDR template.)

Biographical Information on the Composer

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below)

Table 1.1 List of compositions

Name | Genre | Publisher | Difficulty | Date Published
--- | --- | --- | --- | ---
1 | A1 | B1 | C1 | D1
2 | A2 | B2 | C2 | D2
3 | A3 | B3 | C3 | D3

Table 1.2 Discography of Works

Title | Recording Label | Numerical Code | Date Published
--- | --- | --- | ---
1 | A1 | B1 | D1
2 | A2 | B2 | D2
3 | A3 | B3 | D3

Theoretical Analysis

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below)

Stylistic and Technical Considerations

(Within the subheading, you may want to have further subsections. Select Heading 3 for these subsections, as shown below)

Chapter 2 - Music Education Mission Statement

(This is your philosophy of music education. Be certain to include the following: (1) why we teach music in school and how it fits into the overall purpose of schooling; (2) your theories of student learning and theories on how you can influence student learning through the process of teaching; (3) philosophical support that describes the purpose of such thorough score analysis and rehearsal planning; (4) beliefs relating to high achievement, respect for diversity, classroom environment, and your professional responsibility for these elements. Support your beliefs with scholarly references when possible)

Chapter 3 - Quality Literature Selection

(Thoroughly describe your beliefs and reasoning behind selecting quality literature as an ensemble director. Include rationale used for selecting general literature selection, connections to overall curricular purposes, and related literature that supports your rationale for literature selection. You may use the subheadings below if you want to organize your data by topic. For additional subheadings, copy the format and add the titles and narrative)
Chapter 4 - [name of concert selection]

This chapter is included to show a few more examples of headings, subheads, figures, and tables. You can add as many chapters as needed for your ETDR.

Unit I. Composer

(include a thorough biographical narrative of the composer making specific connection to this composition. Be certain to include the reference citations for all data and quotations)

Unit II. Composition

(include a thorough description of the composition such as general background, cultural relevance, unique instrumentation, and any other information that would provide an understanding of the piece)

Unit III. Historical Perspective

(include a thorough background of the historical background relevant to this composition)

Unit IV. Technical Considerations

(This section should be detailed with all technical considerations important to a conductor elaborating and referencing the elements indicated on the score analysis form. Include specific measure numbers, instruments involved, description of the technical challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable)

Unit V. Stylistic Considerations

(This section exposes specific stylistic considerations required for effective performance. These should elaborate on and reference the score analysis form. Include specific measure numbers, instruments involved, description of the stylistic challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable)

Unit VI. Musical Elements

(This section exposes specific musical considerations required for expressive performance. These should elaborate on and reference the score analysis form. Include specific measure numbers, instruments involved, description of the musical challenge and proposed solutions. Also expose important rehearsal considerations referencing the lesson plans when applicable)

Unit VII. Form and Structure

(Provide your overview of the formal structure of the composition. Include relevant information important to the conductor with measure numbers, relevant instrumentation elements, and other necessary information)

Unit VIII. Suggested Listening

(provide a list of suggested listening exposing the aspect for which to listen)

Unit IX. Seating Chart and Acoustical Justification

(describe the seating chart and provide rational support the decisions made in reference to acoustical principles)
Unit X. Rehearsal Plans and Evaluations

Rehearsal Plan – Rehearsal #1

Ensemble:                        Announcements:

Literature:                    Time:
All templates follow with Examples and Tips (instructions)

Chapter 2 - EXAMPLES and TIPS (this is a Heading 1)

(Delete this chapter before publishing!)

Timesaving elements like headings, and caption labels for figures and tables, are shown below. You can modify headings and other styles to meet departmental requirements. Find your Word version at k-state.edu/grad/cdr/word and read the “Using Styles” section.

YOU control the format of your content (Heading 2 example)

From Chapter 1 and on, you and your advisor decide how to format the content. The Graduate School wants consistency, so it will check your content for format issues such as:

- Blank pages
- Figures and tables outside the margins
- Inconsistent line spacing, margins, page numbering, etc.

Use headings and subheadings to organize content (Heading 3 example)

Headings 1-5 are for use in chapters (headings 6-9 are for appendices). Many students only use Headings 1, 2, and 3 in chapters. To organize a Heading 3 section, use Heading 4’s.

Heading 4 is special; it can also be put in a paragraph (Heading 4 example)

Notice that Heading 4 has a half-inch indent. This heading is designed to stand alone on a line or to fit inside a paragraph (which some students need for APA style).

Heading 5 also fits inside a paragraph (Heading 5 example). Be aware that headings inside a paragraph will be shown in the Table of Contents, but do not display in Word’s Navigation Pane.
Figure 1.17 Reger: Sonata for Clarinet and Piano, Op. 107, II. Mm. 28-33

Figure 4.1 Clarinet solo with triplets and "ppp" accompaniment

Episode four consists of a triplet variant of motives one and two, mostly heard in the piano, with two interjections in the clarinet, similar to episode one.
With the latter, the horns have sforzando half notes, adding greater emphasis to the second beat of the measure. These need to be prominent, but will not be played at a true forte because of the dynamic range of the melody.

**Figure 5.4 Trumpet Melody with Horn Sforzando**

Another frequently used melody that first appears in the second clarinet solo begins with a dotted half note, followed by a two-octave leap downward. Strauss frequently uses leaps in his melodies of a fourth or more. Having a good tonal center is necessary to perform them with good intonation and tone. This melody will be called the “Ascending Quarter Note Theme” because of the second measure with the ascending quarter notes.

**Figure 4.3 Ascending Quarter Note Theme**
Contact the **IT Help Desk** if you have questions about these topics:

- Templates and formatting your ETDR
- Reviewing your ETDR and supplemental files
- Working with image or audio files
- Converting your Word or LaTeX file to PDF
- Logging into K-REx to submit your ETDR

<table>
<thead>
<tr>
<th><strong>Table 3. Recommended formats for supplemental files</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of file</strong></td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Numeric data</td>
</tr>
<tr>
<td>Audio</td>
</tr>
<tr>
<td>Video</td>
</tr>
</tbody>
</table>

**IT Help Desk**

214 Hale Library  
785-532-7722 or 800-865-6143  
helpdesk@k-state.edu  
k-state.edu/its/helpdesk

*Want help faster?* Fill out the **IT Help Desk ETDR Request Form** (requires K-State eID/password).
### Table 1.2 Plot Summary for Alcina

#### Act 1

Bradamante, searching for her lover, Ruggerio, arrives on Alcina's island with Ruggerio's former tutor, Melisso. Dressed in armor, Bradamante looks like a young man and goes by the name of her own brother, Alcide. She and Melisso possess a magic ring which enables the wearer to see through illusion, which they plan to use to break Alcina's spells and release her captives.

The first person they meet is the sorceress Morgana. Barely human and with no understanding of true love, she immediately abandons her own lover Oronte for the handsome Ricciardo. Morgana conveys the visitors to Alcina's court, where Bradamante is dismayed to discover that Ruggerio is betrothed with Alcina and in a state of complete amnesia about his previous life. Also at Alcina's court is a boy, Oberto, who is looking for his father, Astolfo, who was last seen heading toward this island. Bradamante guesses that Astolfo is now transformed into a creature by Alcina, but she holds her peace and Concerns herself with Ruggerio. Bradamante and Melisso produce Ruggerio for his delight, but he can think of nothing except Alcina.

Meanwhile, Oronte discovers that Morgana has fallen in love with Ricciardo, and challenges him to a duel. Morgana stops the fight, but Oronte sits in a foul mood and takes it out on Ruggerio. He tells the young man exactly how Alcina treats her former lovers and adds that, as far as he can tell, Alcina has fallen in love with the newcomer, Ricciardo. Ruggerio is horrified and overwhelmed Alcina with her jealous fury. Things get even worse when Ricciardo enters and pretends to admire Alcina. Alcina calms Ruggerio, but Bradamante is so upset at seeing her fiancé weep before her very eyes that she reveals her true identity to Ruggerio. Melisso hastily contrives her and Ruggerio becomes very confused. Alcina tells Morgana that she plans to turn Ricciardo into an animal, just to show Ricciardo how much she really loves him. Morgana begs Ricciardo to escape the island and Alcina's clutches, but he says he'd rather stay, as he loves another. Morgana believes that this other person is herself, and the act ends with her triumphant aria "Tornami a vagheggiar".

#### Act 2

Melisso recalls Ruggerio to reason and duty by letting him wear the magic ring: under its influence, Ruggerio sees the island as it really is—a desert, peopled with monsters. Appalled, he realizes he must leave, and sings the famous aria "Verdi prati" ("Green meadows") where he admits that even though he knows the island and Alcina are mere illusion, their beauty will haunt him for the rest of his life.

Mellisso warns Ruggiero that he can’t just leave: Alcina still wields immense power, and he should cover his escape by telling her that he wishes to go hunting. Ruggiero agrees, but, thoroughly bewildered by the magic and illusion surrounding him, he refuses to believe his eyes when he at last sees Bradamante as herself, believing that she may be another of Alcina's illusions. Bradamante is in despair, as is Alcina. Convinced of Ruggiero's indifference, she enters to turn Ricciardo into an animal, and Ruggiero has to pull himself together quickly and convince the sorceress that he doesn't need any proof of her love. It is at this point that the audience realises that Alcina genuinely loves Ruggiero; from now until the end of the opera, she is depicted sympathetically.

Oronte realises that Ricciardo, Melisso and Ruggiero are in some sort of alliance, and Morgana and Alcina realise they are being deceived. But it is too late. Alcina's powers depend on illusion and, as true love enters her heart, her magic powers slip away. As the act ends, Alcina tries to call up evil spirits to stop Ruggiero from leaving her, but her magic fails her.

#### Act 3

After the opera finishes swiftly, Morgana and Oronte try to rebuild their relationship; she returns to him and he renews her but (once she is offstage) admits he loves her still. Ruggerio returns to his proper heroic status and sings an aria accompanied by high horns; Oberto is introduced to a lion, to whom he feels strangely attached, and Alcina sings a desolate aria as which she longs for oblivion.

Bradamante and Ruggiero decide that they need to destroy the source of Alcina’s magic, usually represented as an urn. Alcina pleads with them, but Ruggiero is deaf to her appeals and slams the urn. As he does so, everything is both ruined and restored. Alcina’s magic palaces crumble to dust and she and Morgana sink into the ground, but Alcina’s lovers are returned to their proper selves. The lion turns into Oberto’s father, Astolfo, and all the other people stumble on, “I was a rock,” says one, “I a tree” says another, “‘I a wave in the ocean...” All the humans sing of their relief and joy, and Alcina is forgotten.
Tables

**Unit VII. Form and Structure**

"Wedding of Kije"

<table>
<thead>
<tr>
<th>Section</th>
<th>Measures</th>
<th>Event and Scoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wedding Theme</td>
<td>1-9</td>
<td>The wedding theme scored for horns, trombones, baritones, tubas, timpani, cymbals, and bass drum; tonal center is E-flat major.</td>
</tr>
<tr>
<td>Lieutenant Kije Theme</td>
<td>9-29</td>
<td>Lieutenant Kije leitmotif, boom-chucks in tuba, horn, and baritones; solo trumpet; Countermelody in second trumpet and bells at measure 21. Tonal center is E-flat major.</td>
</tr>
<tr>
<td>Lieutenant Kije Theme</td>
<td>29-40</td>
<td>Lieutenant Kije leitmotif in a detached style with sforzandos in the horn, trombones take over the previous part played by the horns. Tonal center is E-flat major.</td>
</tr>
<tr>
<td></td>
<td>40-57</td>
<td>Baritone solo (originally scored for tenor saxophone), trombones have brief rhythmic passages. Tonal center is A minor.</td>
</tr>
<tr>
<td>Lieutenant Kije Theme</td>
<td>57-65</td>
<td>Lieutenant Kije leitmotif with countermelody in the two trumpet voices and bells. Tonal center is E-flat major.</td>
</tr>
<tr>
<td>Wedding Theme</td>
<td>65-73</td>
<td>Wedding theme scored for horns, trombones, baritones, tubas, timpani, cymbals, and bass drum; tonal center is E-flat major.</td>
</tr>
<tr>
<td>Lieutenant Kije Theme</td>
<td>73-85</td>
<td>Lieutenant Kije theme in detached style. Tonal center begins in D major and modulates to E-flat major at 83.</td>
</tr>
<tr>
<td>Lieutenant Kije Theme</td>
<td>85-93</td>
<td>Lieutenant Kije leitmotif, played at forte with countermelody beginning at 89. Tonal center is E-flat major.</td>
</tr>
<tr>
<td>Wedding Theme</td>
<td>93-100</td>
<td>Wedding theme scored for horns, trombones, baritones, tubas, timpani, cymbals, and bass drum; tonal center is E-flat major, slight ritardando in 99-100.</td>
</tr>
</tbody>
</table>

**Table 4.1 Selected list of compositions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Genre</th>
<th>Date Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two etudes for horn</td>
<td>Solo Horn</td>
<td>1873</td>
</tr>
<tr>
<td>Overture to the Singspiel Hochlands Treue</td>
<td>Orchestral</td>
<td>1873</td>
</tr>
<tr>
<td>Two Little Pieces for Violin and Piano in G major</td>
<td>Chamber Music</td>
<td>1873</td>
</tr>
<tr>
<td>Concertante for piano, 2 violins and cello</td>
<td>Chamber Music</td>
<td>1875</td>
</tr>
<tr>
<td>Quartet for 2 violins, viola, and cello in C minor</td>
<td>Chamber Music</td>
<td>1875</td>
</tr>
<tr>
<td>Serenade in G Major for orchestra</td>
<td>Orchestral</td>
<td>1877</td>
</tr>
<tr>
<td>Romanze in E-flat Major for clarinet and orchestra</td>
<td>Concerto</td>
<td>1879</td>
</tr>
<tr>
<td>Festmarsch in E-flat Major</td>
<td>Orchestral</td>
<td>1881</td>
</tr>
<tr>
<td>Serenade in E-flat Major for 13 wind instruments</td>
<td>Chamber Music</td>
<td>1882</td>
</tr>
<tr>
<td>Suite in B-flat Major for 13 wind instruments</td>
<td>Chamber Music</td>
<td>1884</td>
</tr>
<tr>
<td>Aus Italien</td>
<td>Orchestral, Tone Poem</td>
<td>1887</td>
</tr>
<tr>
<td>Don Juan</td>
<td>Orchestral, Tone Poem</td>
<td>1889</td>
</tr>
<tr>
<td>Tod und Verklärung</td>
<td>Orchestral, Tone Poem</td>
<td>1890</td>
</tr>
<tr>
<td>Macbeth</td>
<td>Symphonic Poem</td>
<td>1890</td>
</tr>
<tr>
<td>Guntram</td>
<td>Opera</td>
<td>1894</td>
</tr>
<tr>
<td>Till Eulenspiegels lustige Streiche</td>
<td>Symphonic Poem</td>
<td>1895</td>
</tr>
<tr>
<td>Also sprach Zarathustra</td>
<td>Symphonic Poem</td>
<td>1896</td>
</tr>
<tr>
<td>Don Quixote</td>
<td>Orchestral</td>
<td>1898</td>
</tr>
<tr>
<td>Ein Heldenleben</td>
<td>Symphonic Poem</td>
<td>1898</td>
</tr>
</tbody>
</table>
Adding Figure or Table caption

Adding figure and table captions

In chapters, each figure and table must have a caption/label, and each caption must be included in the List of Figures or List of Tables. The easiest way is to INSERT a caption, which lets Word do all the work (apply Caption style, adds numbering, checks sequence, etc.).

- In Word for Windows: References > Captions section > Insert Caption
- In Word for Mac: Insert > Caption

First, ask your adviser about caption format

Caption: Figure 1

Options:
- Label: Figure
- Position: Below selected item
- Include label in caption

Tables (must be trained separately)

3. From then on, simply insert a caption (Insert > Caption), make sure the label is set to
Appendix A - Enter Your Appendix Title Here

- This area is used for your score analysis and supplemental data, but is not required.
- There's no limit on the number of appendices.
- Appendix headings must be labeled A, B, C, etc.

For an option of reporting a score analysis and instructions see the following web links

- SCORE ANALYSIS TEMPLATE
- Instruction for completing Score Analysis
- Inserting Score Analysis into Report
Electronic Theses, Dissertations, and Reports

Electronic Submission

All K-State graduate students are required to submit an electronic version of their thesis, dissertation, or report. The Graduate School does not accept paper copies.

Open Access

Electronic theses, dissertations, and reports (ETDR) submitted by K-State students are openly available through the K-State Research Exchange (K-REx) and are indexed by Google, Google Scholar, and other search engines. For information on copyright and your ETDR (such as how to legally reuse others’ works and what to do if you want to publish sections or chapters of your ETDR with an academic journal), please visit Copyright Information for Graduate Students.

Formatting your ETDR

Your ETDR must follow specific formatting guidelines. The ETDR Handbook outlines these requirements. The ETDR Handbook (pdf) and other tools and resources in this site demonstrate how to correctly format your ETDR to meet Graduate School requirements. ETDR submission and other requirements must be completed by specific deadlines in order for students to graduate and participate in commencement with a designated term. Refer to the Graduation and ETDR Submission Checklist at the beginning of the term in which you intend to graduate to make a plan for completing all requirements on time.

Help

If you have questions on any aspect of your ETDR, help is available through the Graduate School and the Information Technology Help Desk. See Help and Contact Information to determine which office to contact for your specific question.
ETDR review checklist (before K-REx submission)

(You can also use an ETDR Request Form to ask for a preliminary review: kstate.edu/grad/etdr/request)

Required changes for 2017 and on

- 1. Title has “Sentence case” format: Capitalize the first word and proper nouns. For details: kstate.edu/grad/edik/create/sentencecase.html
- 2. Author name: Capitalize Each Word
- 3. Abstract maximum limit: 500 words
- 4. Copyright statement is on one line (see below)

Title page

- Thesis has 1 title page and 1 abstract.
  Title page shows A THESIS OR A REPORT.
- Dissertation has 2 title pages and 2 abstracts.
  1st title page: AN ABSTRACT OF A DISSERTATION
  2nd title page: A DISSERTATION

2017

Previous degree is in chronological order.

- Format: Degree abbreviation, Institution, year
  Example: M.A., Kansas State University, 2015

- Degree being earned is in ALL CAPS and matches K-State’s degrees: kstate.edu/grad/academics

- Departments, colleges, or academic programs must match K-State’s official academic names: kstate.edu/directories/academic.html

- KANSAS STATE UNIVERSITY is in ALL CAPS

- Graduation year only (NOT month or day)

- Appear approved by: Right-justified and blank line after "Approved by"

Copyright page (optional, but the Graduate School strongly recommends)

Serves as a reminder that your work is copyrighted. Required if you plan to register copyright through U.S. Copyright Office or during ProQuest dissertation submission.

Copyright © Will E. Wildcat 2017.

Table of Contents

- Starts with List of Figures. If chapters have no figures (or tables), delete the List of Figures (or List of Tables).
- Does NOT include Copyright, Abstract, or Table of Contents
- Pages before Chapter 1 show Roman numerals
- Chapter 1 starts on Page "1"

Document format

- Chapters, appendices, etc. each start on a new page.
- All pages in inquired order (see Page order at right).
- Consistency is required on headings, captions, margins, line spacing, paragraph alignment, etc.
- Bibliography, references, or citations:
  - Can be at end of each chapter, after final chapter, or both.
  - A blank line must follow each citation.
- Page margins are 1 inch. Left margin may be increased to 1.5 inches for binding larger documents.
  - Exception: Tables and images may extend into the left and right margins as long as each margin is a half-inch minimum.
- PDF conversion

  Word process: File > Save as > Save as type: PDF > Save
  - Optional: To add bookmarks in your PDF for functionality (like the Navigation Pane in Word): Save as type: PDF > Options > Create bookmarks using > Headings > OK
  - Dissertations only: Embed fonts in the PDF for ProQuest. Make embed fonts automatically. On Windows computers, use this process in Word 2016:
    1. File > Save as > More options > Set "Save as type" to PDF
    2. Options > Checkmark ISO (.PDF/A) > OK > Save
  - Check the PDF for conversion problems:
    - Verify every image is correct.
    - Remove any blank pages.
    - Fix awkward page breaks (in Word: use Ctrl-Enter)

Submitting PDF to K-REx (kstate.edu)

- Document must be in PDF format.
- Required filename: Firstname.lastnameYYYY.pdf
  - with complete first name, complete last name, NO spaces, and YYYY format for the year.
  - Example: WilliamWildcat2017.pdf

Page order and numbering

- Dissertations have an extra title page and abstract page.
- Page numbering begins counting on the first page but does NOT display.
- Table of Contents: Page numbering displays as Arabic numerals (I, II, III).
- Chapter 1: Page numbering displays as Roman numerals (I, II, III).

FAQs

- Are there limits on pages or file size? No.
- What if I don’t use figures? Delete the List of Figures page.
- Where should other “List” pages be placed? After the List of Figures and List of Tables, if those are being used.
- What’s a Preface? An optional statement of purpose, scope, or introductory information.
- What I want an Introduction before Chapter 1? Start the introduction on Page 1.
- What are appendices for? Supplemental data such as:
  - Surveys
  - Forms
  - Copyright permissions
  - Data sets
  - Computer code
  - etc.